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ABSTRAKT 
Táto bakalaráska práca sa zaoberá analýzou magnetického poľa magnetoreologickej 
(MR) spojky a využitím zistených poznatkov. Prvá časť práce je spracovaná ako 
rešerše, potrebná pre riešenie daného problému. Nasleduje časť, v ktorej je vytváraný 
model MR spojky. Jeho magnetické pole, vypočítane programom využívajúcim 
metódu konečných prkov (MKP), sa zhoduje s reálne namerenými výsledkami. 
Posledná časť práce je odľahčenie MR spojky, s ohľadom na existujúci model jej 
magnetického poľa. 
 
KĽÚČOVÉ SLOVÁ 
MKP analýza, magnetoreologická spojka, B-H krivka, magnetické pole 
 
ABSTRACT 
This bachelor’s thesis analyses magnetic field of a magnetorheological (MR) clutch  
and works with knowledge of these findings. The first part is treated as a backround 
research required to solve the thesis. Following section is making a model  of MR 
clutch. Its magnetic field, calculated in the program that use the finite element 
method (FEM), matches with actual measured results. The last part of the work is 
lightening the MR clutch, with a respect of the existing magnetic field model. 
 
KEY WORDS 
FEM analysis, magnetorheological clutch, B-H curve, magnetic field 
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1 ÚVOD 
Pri predstave veľmi výkonného automobilu si každý predstaví obrovskú akceleráciu, 
maximálnu rýchlosť, vysoký točiaci moment a iné. Ale výkon je len jedna zo 
zložiek, ktoré potrebuje stroj  pre svoju konkurencieschopnosť. Veľmi dôležité je 
tento výkon preniesť. Túto funkciu, medzi inými, plní spojka.  
Spojka využíva fyzikálny princíp trecích, väzbových, pružných a iných síl. To 
znamená, že keď je spojka zopnutá, sily prenášané cez určité médium (MR 
kvapalina, lamela a iné) držia stator a rotor v súbežných otáčkach. Pri rôznych 
otáčkach statora a rotora je spojka vypnutá alebo, ľudovo povedané, šmýka. 
MR spojka využíva ako médium magnetoreologickú (MR) kvapalinu. Tá je 
charakteristická svojou zmenou vlastností v závislosti na magnetickom poli, 
v ktorom sa nachádza. Pri súčasnom veľkom rozvoji výskumu materiálov, sa hľadajú 
nové konštrukčné riešenia, ktoré by tieto materiály využili.  
Momentálne nie je MR spojka konkurencieschopná ostatným konvenčným spojkám. 
Je to z dôvodu jej mladého a krátkeho rozvoja. Táto bakalárska práca sa venuje 
analýze magnetického obvodu, vďaka ktorému MR kvapalina mení svoju zdanlivú 
viskozitu, a následnému odľahčeniu spojky.  
 

 
Obr. 1.1 Konvenčná dvojlamelová závodná spojka OS Giken [1] 
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2 PREHĽAD SÚČASNÉHO STAVU POZNANIA 
 
 
2.1 MR kvapaliny 
MR kvapaliny sú zaradené medzi tzv. smart (z angl. inteligentné) materiály a to 
v podkategórii field responsive fluids (z angl. kvapaliny reagujúce na pole). Do tejto 
podkategórie patria aj eletroreologické (ER) kvapaliny a niektoré typy polymérnych 
gélov [2]. Hlavná charakteristika MR kvapalín je ich schopnosť sa návratne zmeniť 
z voľne tečúcej, lineárne viskóznej tekutiny, na semi-tuhú látku s medzou klzu rýchlo 
a priebežne kontrolovateľne v prípade vystavenia magnetickému poľu. 
 
 
2.1.1 Princíp a zloženie 
MR kvapaliny sú disperzie obsahujúce polarizovateľné častice (keramické, zliatinové 
alebo kovové) o veľkosti rádovo v mikrometroch rozptýlené vo vodnej alebo 
organickej tekutine. Najpoužívateľnejší magnetický materiál v príprave MR kvapalín 
je vysoko čistý železný prášok (Fe). Ten má prirodzene guličkový tvar a tým 
minimalizuje anizotropiu tvaru magnetického poľa (obr. 2.1). Čo sa týka nosnej 
kvapaliny,  je dôležité, aby nebola reaktívna s magnetickými časticami alebo s 
materiálom, z ktorého sa skladá zariadenie. Hlavné vlastnosti, ktoré musia byť pri jej 
výbere zvážené, sú viskozitný index (udáva mieru zmeny viskozity v závislosti na 
teplote – priorita je, aby došlo k zmenám čo najmenším), antioxidačné vlastnosti, 
teplota varu, teplota tuhnutia a vyparovací tlak pri zvýšenej teplote.  
 

 
Obr. 2.1 Železné častice pod elektrónovým mikroskopom [3] 

 
Práve vo vyššie uvedenom zložení je zapríčinené smart správanie sa MR kvapalín. 
Keď je prítomné magnetické pole, magnetické častice sa zmagnetizujú a začnú 
správať ako malé magnety [4]. Následne  sa usporiadajú do smeru rovnobežného so 
smerom magnetickej indukcie (obr. 2.2, obr. 2.3). 
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Obr. 2.2 Schéma orientácie kovových častíc MR kvapaliny: (a) chaoticky – bez magnetického poľa; 

 (b) – čiastočne zoradené; (c) – plne zoradené [5] 
 

 
Obr. 2.3 Snímky vonkajšieho vzhľadu MR kvapaliny:  
(a) bez magnetického poľa; (b) v magnetickom poli [6] 

 
Takto vzniknuté reťazové štruktúry zabraňujú pohybu kvapaliny a tým zvyšujú 
zdanlivú viskozitu suspenzie. Mechanická energia potrebná na sklz týchto 
reťazových štruktúr sa zvyšuje so zvyšujúcou sa intenzitou magnetického poľa [7]. 
MR kvapalina reaguje na zmenu magnetického poľa v priebehu niekoľkých 
milisekúnd - celková odozva zariadenia je 10 až 20 milisekúnd, a preto predstavujú 
jedny z najrýchlejších elektro-mechanických rozhraní.  
Pre kompletnosť zloženia MR kvapalín je nutné uviesť poslednú zložku a to sú 
aditíva. Ich úlohou je zlepšiť vlastnosti suspenzie a to napr. zabraňovať usádzaniu 
magnetických častíc, vytvárať ochranný plášť na časticiach, zvyšovať odolnosť a 
zabraňovať oxidácií. Pri použití vody, ako tekutej zložky MR kvapaliny, sú 
používané aditíva na kontrolovanie pH [4]. 
 
 
2.1.2 Typy použitia 
Väčšina zariadení, ktoré pracujú na princípe MR kvapalín, používa jeden z troch 
módov toku viď. obr. 2.4: 
 

• Pressure driven flow mode (z angl. tlakom riadený mód toku – ventilový 
mód) - nepohyblivé póly. Tento princíp využívajú tlmiče, tlmiče rázov a 
ventily. Je vhodný pre aplikáciu v automobilových podvozkoch.  

• Direct-shear mode (z angl. mód priameho šmyku – šmykový mód) - relatívne 
pohyblivé póly translačne alebo rotačne kolmo na aplikované magnetické 
pole. Využitie je v spojkách, brzdách, zámkach a tlmičoch so strednými 
frekvenciami pohybu.    
 

 (a)                (b)      (c) 

 (a)              (b)    

2.1.2 



 

 

Prehľad súčasného stavu poznania 
 

strana 

18 

• Squeez-film mode (z angl. mód stláčaného filmu – ťahovo-tlakový) – 
relatívne pohyblivé póly v smere aplikovaného magnetického poľa.  
Reprezentanti tohto módu sú tlmiče využívané pri veľkých zaťaženiach 
a krátkej dráhe pohybu alebo silentbloky [8].  

 

 
 
 
 
2.1.3 História, sučasnosť a budúcnosť 
O prvotný objav a vývoj MR kvapalín sa zaslúžil Američan Jacob Rabinow v roku 
1947.  Jeho práca bola nezávislá no takmer konkurujúca s prácou Willisa Winslowa 
ohľadom ER kvapalín, ktorá vznikla, ako veľa vynálezov, náhodou. Vedci 
používajúci mramor a olej na konštrukciu vysokonapäťových vypínačov si všimli, že 
keď bol vypínač v pracovnom režime, tak sa mramor rozpadol na prášok v oleji, 
ktorý sa zmenil z tekutého stavu na pastu v prítomnosti vysokého napätia [2, 9]. Prvé 
MR kvapaliny boli použité v magneticky riadených spojkách v automobilovom 
priemysle v päťdesiatych a v Apollo opravných moduloch v šesťdesiatych rokoch 20. 
storočia. 
J. David Carlson, ktorý riadi materiálové oddelenie spoločnosti Lord Corp., tvrdí, že 
najväčšia výzva súčasnosti je navýšenie procesu výroby MR kvapalín. „Je veľký 
rozdiel medzi vytvorením 1 litru tejto veci v laboratóriu a vytvorením jej v 218 
litrových galónoch pre automobilový priemysel,“ hovorí, poukazujúc na to, že takýto 
sud MR kvapaliny váži približne pol tony. „Logisticky povedané, je to výzva 
miešania a manipulácie s materiálom vo veľkej miere.“ Napriek tomu sa MR 
kvapaliny objavili v automobiloch ako Chevrolet Corvette 2003, Audi R8, Ferrari 
599GTB, Ferrari 458 Italia, Range Rover Evoque a iné. Japonský inžinieri bolí prví, 
ktorí použili MR tlmiacu technológiu ako pomoc, pre stabilizovanie budov pri 
zemetraseniach  a  to  v  japonskom  Múzeu vznikajúcej vedy a techniky v Tokiu 
(obr. 2.5). 
Vedci vidia budúcnosť napríklad vo vstrekovaní biokompatibilnej MR kvapaliny 
priamo do krvného obehu, kde by boli schopní kontrolovať tok krvi do rakovinových 
nádorov. Alebo možno budú prúdiť v žilách robotov, aby mohli vytvoriť pohyb rúk 
a končatín prirodzený ako ľudia [10]. 
 
 
 
 
 
 
 
 

Obr. 2.4 Zaťažovacie módy MR kvapalín: (a) ventilový; (b) šmykový; (c) ťahovo-tlakový [3] 

 

     (a)            (b)       (c) 
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2.2 Magnetostatická analýza v ANSYS Workbench 
Magnetické pole vzniká ako odozva na elektromagnet (je tvorený cievkou navinutou 
z drôtu okolo oceľového jadra, ktorou prechádza elektrický prúd) alebo magnet 
permanentný [11].  Magnetostatic je názov magnetickej analýzy, ktorú ponúka MKP 
program ANSYS Workbench. Typické použitie tejto analýzy je v elektrických 
zariadeniach, transformátoroch, pri indukčnom ohreve, elektromagnetických 
pohonoch, urýchľovačoch častíc, lekárskych a geofyzikálnych nástrojoch i iných.  
Magnetostatic analýza vyžaduje pre svoje použitie niekoľko nevyhnutných 
podmienok, ako aj dovoľuje určité operácie: 
 

• Model musí mať 3-D geometriu. 
• Geometria musí pozostávať z jedného telesa – v prípade sústavy telies slúži 

príkaz multibody part (viď. Príloha I). Ten zadefinuje kontaktné plochy 
súčiastok, pretože Magnetostatic používa prvok SOLID117, ktorý 
nepodporuje kontaktné elementy.  

• Vzduch obklopujúci skúmanú fyzikálnu geometriu musí byť vymodelovaný 
ako časť celkovej geometrie – príkaz Enclosure (viď. Príloha I). Je dôležité, 
aby výsledná geometria bola jedno teleso spolu so vzduchom (multibody 
part). 

• Pri použití symetrického modelu je pre zrýchlenie výpočtu vhodné využiť 
nástroj Symmetry. Ten dokáže rozdeliť plne symetrický model alebo 
identifikovať roviny symetrie pri časti symetrického modelu.  

• Umožňuje multi-step solution – riešenie rozdelené do krokov.  
 
Workbench odporúča používať čo najmenej pyramídových elementov v kritických 
oblastiach modelu, ktoré sú aplikované na spájanie z hexagonálnych elementov na 
tetrahedróny. Túto minimalizáciu je možné dosiahnuť špecifikovaním tvaru 
elementov v príkaze Method (viz. Príloha I). Pre detailnejšie možnosti ohľadom 
nastavenia siete odporúčam hľadať v [12] výraz „Physics Preference,“ kde sú 
uvedené aj vysvetlivky. 

Obr. 2.5 Seizmický tlmič od firmy Lord použitý v Múzeu  
vznikajúcej vedy a techniky v Tokiu [9] 

2.2 
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2.2.1 Solver Controls 
Solver Controls (z angl. ovládanie riešiča) ponúka dve metódy riešenia a to je priama 
alebo iteračná. Pri priamej metóde je konvergencia zaručená, ale jej nevýhodou je 
technická náročnosť výpočtu zo stránky operačnej pamäte. Pri použití iteračnej 
metódy nenastáva problém s operačnou pamäťou, na druhej strane nie je zaručená 
konvergencia.  
Typ riešiča je špecifikovaný príkazom EQSLV. Ten sa skladá z viacerých vstupných 
parametrov ako je Lab, TOLER, MULT, KeepFile (spôsob zadávania príkazu viď. 
Príloha I).  
 
Lab špecifikuje typ riešiča rovnice: 
 

(a) Priame: 
• SPARSE – Prednastavený (Program Controlled, Direct) riešič, ktorý je 

alternatívou iteračných riešičov, pretože kombinuje rýchlosť a robustnosť. 
Všeobecne platí, že potrebuje operačnú pamäť zrovnateľnú s PCG riešičom.  
 

(b) Iteračné: 
• PCG – Pre-codnitioned Conjugate Gradient riešič. Vyžaduje menej miesta 

na disku ako SPARSE, je rýchlejší pre väčšie modely a je vhodný pre 
nelineárne analýzy. Vyžaduje dvojnásobok operačnej pamäte oproti JCG 
riešiču. Dokáže zvládnuť zle podmienené matice. 

• JCG – Jacobi Conjugate Gradient riešič. Efektívny pre prenos tepla, 
elektomagnetizmus, piezoelektrizmus a akustické problémy. 

• ICCG – Incomplete Conjugate Gradient prednastavený riešič (Iterative), 
ktorý využíva viac operačnej pamäte ako JCG, ale je aj viac robustný pre zle 
podmienené matice. 

• ITER – Automaticky volí iteračný riešič pre konkrétne vlastnosti riešeného 
problému. Je dostupný len pre elektrostatické, ustálené alebo prechodne 
tepelné, lineárne statické a plne prechodné štrukturálne analýzy bez 
superelementov. Ak je použitý automatický iteračný riešič, ale podmienky 
pre výber nie sú splnené, program prepne na SPARSE riešič.  

• QMR – Quasi-Minimal Residual iteračný riešič. Dostupný pre štruktúrne, 
kvapalinové, magnetické a elektrické stupne voľnosti. Tento riešič je 
vhodný pre vysokofrekvenčné magnetické aplikácie, a pritom je stabilnejší 
ako ICCG. 

 
Podrobnejšie informácie ohľadom riešičov sú v [11] v kategórii „EQSLV.“ 
Ďalší parameter príkazu EQSLV je MULT, ktorý kontroluje maximálny počet iterácii 
uskutočnených počas výpočtov. Používa sa len v spojení s PCG riešičom. 
Prednastavená hodnota je 2,5 pre nelineárne a 1,0 pre lineárne analýzy.  Maximálny 
počet iterácii je rovný MULT*DOF, pričom DOF (Degrees of Freedom) je počet 
stupňov voľnosti. Iterácie pokračujú dokým nebola dosiahnutá konvergencia riešenia 
alebo nebol vykonaný maximálny počet iterácii. Ak riešenie nekonverguje pre 
hodnoty 1,0 ≤ MULT ≤ 3,0 alebo pre menej ako 10 000 iterácii, je veľká 
pravdepodobnosť, že konvergencia nenastane vôbec a je potrebná úprava modelu. 
Pri riešení magnetického poľa je veľmi dôležité držať sa rád, ktoré nám program 
ANSYS Workbench ponúka. Zdroje týchto rád sú v Solution Information (viď. 
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Príloha I) a v Helpe [12]. Pri jednoduchých modeloch, sa dá použiť metóda pokus-
omyl. Ako náhle je model zložitejší, jeho výpočet trvá veľmi dlho (rádovo aj dni), 
a preto strácame veľa času, ktorý v praxi samozrejme nemáme. 
 
 
2.3 MR spojky 
Magnetoreologické spojky sú charakteristické veľmi dobrou kontrolovateľnosťou 
prenášaného točivého momentu a malými reakčnými časmi. Najväčšia výhoda oproti 
bežným spojkám pozostáva v ich elektrickom ovládaní bez mechanizmov. 
Vzhľadom na niekoľko nevyriešených problémov, MR spojky zatiaľ nezaplnili 
veľkú časť trhu.  
 
 
2.3.1 Rozdelenie MR spojok 
Rozdelenie, ktoré si popíšeme, je na spojky s axiálnou a radiálnou medzerou: 

 
(a) Axiálna medzera 

 

 
Obr. 2.6 Schéma MR spojky s axiálnou medzerou [13] 

 
Zdanlivá viskozita MR kvapaliny sa zvyšuje so zväčšujúcim sa polomerom r (viď. 
obr. 2.6). Spojky s axiálnou medzerou sa vyznačujú skokovou zmenou prenášaného 
točivého momentu pri prechode z neaktivovaného do aktivovaného stavu. Tento 
nechcený jav môže byť obmedzený voľbou vhodnej geometrie a to vnútorného 
polomeru Ri a vonkajšieho R0 [14]. 
 

 
 

  

2.3 

2.3.1 
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(b) Radiálna medzera 
 

 
Obr. 2.7 Schéma MR spojky s radiálnou medzerou [13] 

 
Pre malé hrúbky medzery s sa zdanlivá viskozita MR kvapaliny zvyšuje so 
zväčšujúcou sa dĺžkou medzery L  (viď. obr. 2.7). Pri týchto spojkách dochádza 
k plynulej zmene prenášaného točivého momentu [14]. 
Na obrázkoch obr. 2.8 a obr. 2.9 sú uvedené vybrané konštrukčné riešenia MR 
spojok. 
 

 
Obr. 2.8 Dvojdisková axiálna MR spojka [15] 
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Obr. 2.9 Multidiskový axiálny MR diferenciál [16] 

 
 
2.3.2 Konštrukcia existujúcej MR spojky 
Z obr. 2.10 a tab. 2.1 je zrejmé ktoré časti spojky majú na jej hmotnosť najväčší 
vplyv. Je to Ľavá a Pravá časť statoru. Hriadeľ je relatívne objemný, ale je vyrobený 
z ľahkej duralovej liatiny, takže je zachovaná jeho nízka hmotnosť. Dôvod, prečo 
tento materiál nie je použitý pri ostatných častiach spojky je jeho paramagnetizmus 
(veľmi mierne zosilňuje magnetické pole viď kap. 2.4). Na rozdiel od Hriadeľa, Ľavá 
a Pravá časť plnia funkciu lamiel, takže musia magnetické pole zosilňovať výrazne – 
– musia byť vyrobené z feromagnetickej látky napr. z ocele.  

 
   

Súčiastka Materiál Hmotnosť [kg] 
Pravá časť statoru oceľ 1,004 
Ľavá časť statoru oceľ 1,276 
Hriadeľ dural 0,052 
Lamela statorová oceľ 0,361 
Lamela rotorová oceľ 0,261 
Rámček vonkajší dural 0,061 
Príložka vonkajšia hliník 0,044 
Obal cievky plast 0,009 
Cievka meď 0,369 
Celkovo 3,437 

 
  

Tab. 2.1  Hmotnosti jednotlivých súčiastok zostrojenej MR spojky 

Output Plate Spacers 

Input Side Cap 

Input Shaft Bearing 

Input Shaft 

O-ring Section 

Outer Casing 

Output Shaft Bearing 

Output Shaft 

Inner Casing 
Electromagnet Care 

Output Side Cap 

Input Plate Spacers 

2.3.2 
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Obr. 2.10 Zjednodušený model zostrojenej MR spojky [14] 

  
 
2.4 B-H krivky 
B-H krivky sú matematicky popísané rovnicou: 
  

� � ����� (1) 
 
kde: 
B T magnetická indukcia 
H A.m-1 intenzita magnetického poľa 
µ0 H.m-1 permeabilita vákua 
µr - relatívna permeabilita 
 
Vzťah potrebný pre veľkosť magnetickej indukcie je: 
 

� �
�

�
 (2) 

 
kde: 
∅ Wb magnetický indukčný tok 
S m2 plocha, ktorou prechádza magnetický indukčný tok 
 
 
 

Pravá časť statoru Ľavá časť statoru 

Cievka 

Rámček vonkajší Príložka vonkajšia 

Obal cievky 

Lamela statorová 

Lamely rotorové 

MR medzera 

Hriadeľ 
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Vzťah (2) vyjadruje dôležitú nepriamu úmeru, kde so zmenšujúcou plochou sa 
zväčšuje magnetická indukcia. Magnetický indukčný tok je závislý na el. prúde 
pretekajúcom cievkou, geometrických vlastnostiach cievky a vedenia.  
Na obr. 2.11 sú zobrazené B-H krivky rôznych materiálov a to lineárnych (vzduch) 
a nelineárnych (oceľ, železo). Vzťah (1) nám predstavuje B-H krivku, z ktorej vidno 
smernicu – permeabilitu –  sklonu krivky závislosti magnetickej indukcie B na 
intenzite magnetického poľa H. Z matematiky je dobre známe, že priamky majú 
nemennú smernicu (lineárne materiály majú konštantnú permeabilitu) a nelineárne 
krivky majú smernicu premenlivú (nelineárne materiály majú premennú 
permeabilitu). Táto zmena veľkosti permeability je spôsobená zoradením sa veľmi 
malých častíc materiálu. Tie sú pri určitej hodnote intenzity magnetického poľa 
zoradené v najdokonalejšej možnej polohe, a preto so zvyšujúcou sa intenzitou 
magnetického poľa nedochádza k zmene magnetickej indukcie. 
 

 
Obr. 2.11 B-H krivky ocele, železe a vzduchu [17] 

Materiály môžeme rozdeliť na tri základné skupiny (obr. 2.12) podľa toho ako 
reagujú na vonkajšie magnetické pole: 
 

• feromagnetické – na magnetické pole reagujú najsilnejšie, sú schopné byť 
zmagnetizované tzn. aj po zániku vonkajšieho magnetického poľa dokážu 
udržať magnetizmus. Vo všeobecnosti platí, že výrazne zosilňujú silové 
účinky magnetického poľa. Pre permeabilitu feromagnetických látok platí µf 
>> µ0, pričom µ0 je permeabilita vákua. 

• paramagnetické – tieto látky sa správajú magneticky, len v prítomnosti 
vonkajšieho magnetického poľa, µp > µ0. 

• diamagnetické – po vložení takéhoto materiálu do magnetického poľa sa 
zoslabí tzn. µd < µ0. 

 
Obr. 2.12 B-H krivka feromagnetického (sivá), paramagnetického (modrá), 

diamagnetického materiálu (zelená) a vákua (červená) [18]
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3 FORMULÁCIA RIEŠENÉHO PROBLÉMU A JEHO ANALÝZA 
V súčasnosti nevieme ako vypadá magnetické pole v jednotlivých častiach obvodu 
alebo v oblasti mimo meracej drážky, v ktorej máme výsledky z merania Hallovou 
sondou. Tá ma hrúbku 1 mm a pre jej aplikáciu je nutná vyššie spomínaná drážka.  
Preto sa objavuje ďalší problém, a to ako veľmi drážka ovplyvňuje jej okolie 
z hľadiska magnetického správania. Reálne namerané výsledky poslúžia ako 
porovnanie s MKP výsledkami.  
Aby sme boli schopní navrhnúť odľahčenie spojky, ktoré je potrebné z dôvodu 
jej vysokej hmotnosti v dôsledku predimenzovania niektorých súčiastok, je nutné 
poznať správanie sa magnetického poľa v pevných častiach. Takéto meranie 
Hallovou sondou je nemožné. Preto sa ako možnosť naskytuje vytvorenie 
virtuálneho modelu – MKP analýza, na základe ktorého môžeme navrhnúť 
odľahčenie a po realizácii ho aj overiť. 
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4 VYMEDZENIE CIEĽU PRÁCE 
Hlavný cieľ bakalárskej práce je vytvorenie zatiaľ neexistujúceho modelu 
magnetického poľa zostrojenej MR spojky a jeho overenie. Nasleduje odľahčenie 
spojky s ohľadom na zachovanie jej funkcie, ktoré bude experimentálne overené. Pri 
riešení sa objavuje vedľajší cieľ a to zostavenie postupu – návodu – pre analýzu 
magnetického poľa. 
 
Kontrolovateľné ciele: 
 

1. Zistenie rozloženia magnetického poľa v zadanej MR spojke použitím MKP 
softwaru ANSYS Workbench. 

2. Porovnanie magnetického poľa na MKP modeli s reálne nameranými 
výsledkami na existujúcej MR spojke. 

3. Zmenšenie hmotnosti spojky s využitím znalostí o rozložení magnetického 
poľa z predchádzajúcich bodov. 

 
Obr. 4.1 Rozpad existujúcej MR spojky na jednotlivé komponenty [14] 

4 
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5 NÁVRH METODICKÉHO PRÍSTUPU K RIEŠENIU 
Pri riešení bakalárskej práce sa postupovalo podľa tohto metodického postupu. 
 
Rešerše 
Táto časť je zameraná na získanie informácií ohľadom MR kvapalín, MR spojok, 
magnetických materiálov a ANSYS Workbench pre lepšie uvedenie do 
problematiky. Slúži ako teoretický základ nevyhnutný pre riešenie zadanej 
bakalárskej práce.   
 
Rozloženie magnetického poľa zjednodušeného modelu MR spojky 
Najprv je vytvorený zjednodušený model MR spojky, na ktorom sú zisťované 
potrebné kroky pre vytvorenie magnetického poľa pomocou MKP analýzy. Model 
neobsahuje skosenia, zaoblenia, diery, niektoré nepodstatné súčiastky (napr. ložiská) 
a používa magneticky lineárne materiály. Sú v ňom zjednodušené aj tvary niektorých 
častí spojky, pre zvýšenie rýchlosti výpočtu a lepšiu manipuláciu s výsledkami.  
 
Postupný prechod na reálny model 
V tomto štádiu je postup vytvorenia magnetického poľa v programe ANSYS 
Workbench dobre známy. Úlohou je zistiť, ktoré zjednodušenia je nevyhnutné zrušiť, 
aby sme sa čo najviac priblížili reálnym meraniam magnetického poľa.  Nasleduje 
zjemnenie mriežky, pre zvýšenú presnosť výpočtu, a hľadanie vhodného riešiča.  
 
Návrh odľahčenia  
Tento návrh vychádza z MKP modelu spojky s výhodne vybranou hustotou mriežky 
s ohľadom na výpočtový čas a presnosť výpočtu. Následne je vytvorená odľahčená 
geometria MR spojky v CAD programe, ktorá je privedená do MKP softwaru. 
V ňom sa vypočíta magnetické pole a zhodnotí, či navrhovaný odber materiálu je 
prijateľný.  
 
Realizácia odľahčenia 
Spojka sa odľahčí na navrhované rozmery vhodnou technologickou operáciou 
v jednom kroku. Tzn. veľkosť celkového odberu materiálu je zhodná s navrhovaným.  
 
Experimentálne overenie navrhnutej zmeny 
Overenie sa skladá z porovnania magnetickej indukcie, ktorú očakávame na základe 
odľahčeného MKP modelu a ktorá je nameraná po celkovom navrhovanom 
odľahčení spojky Hallovou sondou. 



 

 

Analýza a interpretácia získaných údajov 

strana 

29 

6 ANALÝZA A INTERPRETÁCIA ZÍSKANÝCH ÚDAJOV 
Reálne namerané hodnoty magnetickej indukcie (obr. 6.1) vznikli pri meraní 
Hallovou sondou v meracej drážke MR spojky, ktorá nebola naplnená MR 
kvapalinou, ale v MR medzere sa nachádzal vzduch [19]. Meralo sa pri el. prúde 
prechádzajúcom 100 závitovou cievkou 1,5 A. Pre cievky platí vzťah: 
 

	
 � �. 
 � 1,5�. 100
á��� � 150�. 
á��� (3) 
 
kde:  
Um  A.závit elektromotorické napätie 
I  A  el. prúd prechádzajúci cievkou 
z  závit počet závitov cievky 
 
My používame v modeli MR spojky zjednodušenú cievku, ktorá ma 4 závity a preto 
prepočítame  el. prúd prechádzajúci cievkou z upravenej verzie vzorca (3) pri 
zachovaní konštantného elektromotorického napätia: 
 

� �
	




�
150�. 
á���

4
á����
� 37,5� (4) 

 
Preto budeme v MKP analýze ako budiaci el. prúd zadávať hodnotu 37,5A (viď. 
Príloha I). 
 

 
Obr. 6.1 Graf reálne nameraných hodnôt magnetickej indukcie Hallovou sondou [19] 
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Analýza a interpretácia získaných údajov 
 

 
Obr. 6.2 Rozmery MR spojky v radiálnom smere 

 

 
6.1 Zjednodušený model verzia 1 
Model neobsahuje šróby, ložiská, meraciu drážku, zaoblenia, skosenia a je v ňom 
upravená MR medzera (obr. 6.3). V ANSYS Workbench pracujeme s magneticky 
lineárnym materiálom statoru a lamiel s relatívnou permeabilitou 2 000.  
Dôvod použitia takéhoto jednoduchého modelu je uvedený v kap. 5 a to je zistenie 
potrebných krokov a operácii, pre určenie magnetickej indukcie v MKP programe. 
Z hľadiska hustoty mriežky je celkový počet elementov 177 314. 
Magnetostatic analýza podporuje riešenie symetrických úloh (viď kap. 2.2). Tento 
najjednoduchší model MR spojky je ale riešený ako 3D teleso, pretože 
predpokladáme zrušenie určitých zjednodušení, ktoré nie je možné v symetrii 
definovať a ktoré nám výrazne spresnia výsledky. 

 

 
Obr. 6.3 Zjednodušený model verzia 1 

Vzdialenosť od osy hriadeľa [mm] 
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Magnetickú indukciu vypočítavame v strede MR medzery, ktorá má hrúbku 0,5 mm 
(obr. 6.4). Graf na obr. 6.5 je číselné vyjadrenie hodnôt magnetických indukcií na 
dráhe medzi bodmi 1 a 2, ktoré sú na obr. 6.4. Na tomto grafe vidíme rozdiel 
medzi reálne nameranými hodnotami a MKP výsledkami, ktorý v porovnaní maxím 
predstavuje relatívnu chybu 151%.  
 

 
Obr. 6.4 Dráha vypočítavanej magnetickej indukcie v strede MR medzery 

 

 
Obr. 6.5 Graf reálne nameraných hodnôt a MKP vypočítaných  

magnetických indukcií Zjedodušeného modelu verzia 1 
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Analýza a interpretácia získaných údajov 
 

6.2 Zjednodušený model verzia 2 
V predchádzajúcej verzii modelu sme zistili, že medzi MKP vypočítanými 
a nameranými výsledkami Hallovou sondou je výrazný rozdiel. Ako prvé riešenie 
nás napadá vytvorenie meracej drážky. Tá má šírku 4,5 mm; skutočnú hĺbku 0,8 mm 
a nachádza sa na Ľavej časti statoru. Preto Ľavú časť statoru nahradíme modelom 
zobrazeným na obr. 6.6. Meracej drážke sme doteraz neprikladali veľký vplyv na 
vypočítanú magnetickú indukciu, kvôli jej malým rozmerom. 
 

 
Obr. 6.6 Ľavá časť statoru s meracou drážkou 

Pri počítaní magnetickej indukcie na MKP modeli s meracou drážkou použijeme dve 
variácie materiálu lamiel a statoru, a to magneticky lineárny (rovnaký ako v modeli 
kap. 6.1) a nelineárny (1018 Steel 90,5 HRB). Dráhu, na ktorej budeme počítať 
magnetickú indukciu pomocou MKP, umiestnime 0,5 mm odo dna meracej drážky. 
Vyplýva to z rozmerov Hallovej sondy, u ktorej predpokladáme, že meria 
magnetickú indukciu v strede svojej hrúbky, ktorá je 1 mm.   
Graf reálne nameranej a MKP vypočítanej magnetickej indukcie pri použití 
magneticky lineárneho a nelineárneho materiálu statoru a lamiel (obr. 6.7) ukazuje, 
že existencia meracej drážky má na výsledky veľký vplyv. Trendy všetkých troch 
kriviek sa veľmi podobajú. Chyba počítaná medzi extrémami je pri lineárnom 
materiáli 37% a pri nelineárnom materiáli predstavuje 28%. Preto ďalej budeme 
používať magneticky nelineárny materiál statoru a zistíme, ktoré zjednodušenia majú 
zásadný vplyv na priblíženie sa reálne nameraným hodnotám. 
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Obr. 6.7 Graf reálne namerných a MKP vypočítaných magnetických indukcií  

Zjednodušeného modelu verzia 2 s lineárnym a nelineárnym materiálom 

 

Dôvod veľkého rozdielu medzi Zjednodušeným modelom verzia 1 a 2 je správanie sa 
meracej drážky ako vrubu na magnetické pole (obr. 6.8). Ďalšie vysvetlenie je 
v umiestnení dráhy meraného a počítaného magnetického poľa. V Zjednodušenom 
modeli verzia 1 (kap. 6.1) je meraná a počítaná dráha v rôznych oblastiach materiálu. 
 

 
Obr. 6.8 Vplyv meracej drážky na magnetickú indukciu MR  

medzery pri použití nelineárneho materiálu 
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Analýza a interpretácia získaných údajov 
 

6.3 Skutočný model verzia 1 
V tejto kapitole zisťujeme aký vplyv na magnetické pole majú spojovacie šróby, a 
preto Zjednodušený model verzia 2 upravíme o všetky otvory pre šróby a kolíky 
(obr. 6.9). Tieto otvory budú v ANSYS Workbench DesignModeler pomocou príkazu 
Enclosure (viď. Príloha I.) vyplnené telesami, ktorým priradíme kovový materiál. 
Ten bude najprv magneticky lineárny s relatívnou permeabilitou 800 a následne 
magneticky nelineárny 1018 Steel 90,5 HRB. 
 

 
Obr. 6.9 Skutočný model verzia 1 

MKP model má 210 261 elementov. Pri nelineárnom materiáli šróbov vyžadoval 
výpočet 2 050 sekúnd a 1 246 MB operačnej pamäte. Model s lineárnym materiálom 
šróbov bol menej náročný, trval 647 sekúnd a potreboval 1 249 MB. Z grafu na obr. 
6.10 sa dá vyčítať relatívna chyba maxím, voči reálne nameraným hodnotám, pri 
lineárnom materiáli na 11% a pri nelineárnom to činí 10%. Rozdiel týchto dvoch 
odchyliek je nevýrazný vzhľadom na rozdiel výpočtových časov, a preto budeme 
ďalej pracovať s magneticky lineárnym materiálom šróbov s relatívnou 
permeabilitou 800.   
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Obr. 6.10 Graf reálne nameraných a MKP vypočítaných magnetických indukcií  

Skutočného modelu verzia 1 s lineárnym a nelineárnym materiálom šróbov 
 

 

6.4 Skutočný model verzia 2 
V predchádzajúcej kapitole sme sa venovali modelu MR spojky s otvormi, ktoré 
reprezentovali priechodzie šróby. V skutočnosti sú šróby zašróbované len do určitej 
vzdialenosti a zvyšok otvoru je zaplnený paramagnetickým vzduchom. Preto 
vymodelujeme hriadeľ, ktorý bude obsahovať nepriechodzie diery do vzdialenosti 3 
mm, čo predstavuje skutočnú dĺžku zašróbovanej časti šróbu v hriadeli (obr. 6.11). 
Ako aj v predošlých kapitolách, urobíme dve variácie a to pri magneticky lineárnom 
a nelineárnom materiáli šróbov. Na základe skúseností predpokladáme, že 
magneticky nelineárny materiál šróbov rapídne zvýši výpočtovú náročnosť pri 
minimálnom spresnení výpočtu. 
 

 
Obr. 6.11 Hriadeľ s nepriechodzími otvormi 
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Použitím nepriechodzích otvorov na Hriadeli, sme sa s relatívnou chybou medzi 
maximami dostali na hodnotu 1% (obr. 6.12).  Dôvod je v toku magnetickej 
indukcie. V prípade priechodzích dier dochádza k „skratu magnetického obvodu“ 
a magnetická indukcia prechádza od jednej lamely k druhej skrz feromagnetické 
šróby (obr. 6.13). V prípade uzatvorenia dier na hriadeli - vytvorenie nepriechodzích 
otvorov - sa magnetická indukcia cez diery v hriadeli nedostane tak ľahko a preto ich 
musí vzduchovou medzerou obchádzať (obr. 6.14). 
Pri použití magneticky lineárneho a nelineárneho materiálu nepriechodzích šróbov na 
hriadeli sú MKP vypočítané výsledky veľmi podobné, pričom aj výpočtová 
náročnosť sa neodlišuje. Pre jednoduchosť budeme používať magneticky lineárne 
šróby s relatívnou permeabilitou 800. 
 

 
Obr. 6.12 Graf reálne nameraných a MKP vypočítaných magnetických indukcií  

Skutočného modelu verzia 2 s lineaárnym a nelineárnym materiálom šróbov 
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Obr. 6.13 Dráha toku magnetickej indukcie v Skutočnom modeli verzia 1 

 

 
Obr. 6.14 Dráha toku magnetickej indukcie v Skutočnom modeli verzia 2 

Obr. 6.15 predstavuje graf ako sme sa postupne približovali reálne nameraným 
hodnotám v dôsledku zrušenia jednotlivých zjednodušení.  
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Obr. 6.15 Porovnania magnetických indukcií skúmaných  

modelov s reálne nameranými hodnotami 
 
 
6.5 Zjemňovanie mriežky 
Máme vytvorený model magnetického poľa MR spojky, ktorý sa dostatočne zhoduje 
s reálne nameranými výsledkami. Tento model je Skutočný model verzia 2 
s magneticky lineárnymi šróbami (kap. 6.4). Nasleduje nájdenie vhodnej hustoty 
mriežky z hľadiska presnosti a náročnosti výpočtu. Vlastnosti mriežok, ktoré 
porovnávame sú uvedené v tab. 6.1. 

 
 

Model Hrubý Stredne hrubý Jemný 
MR medzera, lamely 2 mm 1,5 mm 1 mm 
Cievka 2 mm 2 mm 2 mm 
Stator, hriadeľ 6 mm 3 mm 2 mm 
Šróby Default 2 mm 2 mm 
Príložka, rámček, 
obal cievky 

Default 2 mm 2 mm 

Vzduchové okolie 10 mm 10 mm 8 mm 
Počet elementov 375 934 754 517 1 724 289 
Výpočtový čas 1 160 sekúnd 2 077 sekúnd 691 872 sekúnd 
Operačná pamäť 1 192 MB 2 373 MB 4 009 MB 
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Obr. 6.16 Graf reálne nameraných a MKP vypočítaných  

magnetických indukcií pri rôznej veľkosti elementov 
 
Na grafe obr. 6.16 vidno, že keď použijeme model s veľkosťou elementu MR 
medzery 2 mm, tak sa približuje reálne nameraným výsledkom najviac (rovnako ako 
je uvedené v úlohe Prílohy III). Preto na odľahčenie použijeme Hrubý model s 2 mm 
veľkosťou elementu MR medzery. Vzhľadom na výpočtový čas prípadne pamäť (tab. 
6.1) a na rozdiel vypočítaných a nameraných hodnôt sa javí ako najprijateľnejší 
a dostatočný. 
 

 

6.6 Odľahčenie statorovej časti 
Doteraz sme pracovali s Hrubým modelom mriežky, kde je veľkosť elementu statora 
6 mm (tab. 6.1). Pretože skúmame magnetickú indukciu v statorovej časti, tak 
rozmery elementov statora zmenšíme na 3 mm. Tým vznikne mriežka s 450 650 
elementmi, ktorú za čas 2 873 sekúnd a s potrebnou operačnou pamäťou 1 145 MB 
MKP program vypočítal.  
Z B-H krivky materiálu odľahčovanej Ľavej a Pravej časti statoru (obr. 6.17) je 
zrejmé, že magnetická indukcia narastá s najväčším stúpaním do hodnoty 0,9 T. 
Tzn., že v prípade zvýšenia magnetickej indukcie o rovnakú hodnotu v oblasti do 0,9 
T na to potrebujeme menej energie, ktorú charakterizuje intenzita magnetického 
poľa, ako keď sa nachádzame v oblasti nad 0,9 T.  
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Obr. 6.17 B-H krivka magneticky nelineárneho materiálu Steel 1018 90.5 HRB [20] 

 
Keďže MR spojka v prevádzkovom stave obsahuje v MR medzere MR kvapalinu 
LORD 140 CG aj v MKP modeli zadefinujeme magnetické vlastnosti materiálu, 
ktorý bude túto  MR  kvapalinu reprezentovať (spôsob zadávania viď. Príloha IV). 
B-H krivka používanej MR kvapaliny je na obr. 6.18. 
Hlavný dôvod, prečo predpokladáme zmenu hodnôt magnetickej indukcie pri spojke 
s MR kvapalinou, je v magnetickom odpore, ktorý kladie vzduchom vyplnená MR 
medzera. MR kvapalina má permeabilitu približne 7 až 9 podľa nasýtenia, čiže odpor 
celého obvodu spojky sa zníži, zvýši sa magnetický indukčný tok a tým aj 
magnetická indukcia. Vzduchom vyplnená MR medzera má význam pre overenie 
MKP analýzy, pretože Hallovou sondou sa nedá merať spojka s MR kvapalinou. 
 

 
Obr. 6.18 B-H krivka MR kvapaliny LORD 140CG [21] 

 
Magnetická indukcia v statorovej časti spojky s použitím modelu s MR kvapalinou je 
zobrazená na obr. 6.19. V porovnaní so vzduchom vyplnenou MR medzerou (obr. 
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6.20) je zrejmé, že dochádza k nasycovaniu feromagnetického materiálu v čelných 
oblastiach. Vtedy el. prúd prechádzajúci cievkou, ktorý funguje ako vstupná energia, 
je využitý menej efektívne. Odľahčenie čelných plôch z hľadiska dosiahnutia 
magnetickej indukcie do 0,9 T nie je možné. Na obvode statoru je magnetická 
indukcia menšia ako 0,9 T; a preto navrhneme odber materiálu statoru po obvode 
spojky.  
 

 
Obr. 6.19 Magnetická indukcia v statore MKP modelu s MR kvapalinou 

 

 
Obr. 6.20 Magnetická indukcia v statore MKP modelu so vzduchom vyplnenou MR medzerou 
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Vonkajší priemer statoru (Ľavá a Pravá časť) zmenšíme o 2 mm, tzn. z priemeru 148 
mm docielime priemer 146 mm (obr. 6.21). Týmto odberom materiálu znížime 
hmotnosť o hodnotu podľa tab. 6.2.  
 

 
Obr. 6.21 Stator odľahčený po obvode 

 Pôvodné Odľahčené 
Hmotnosť Ľavej 
a Pravej časti [kg] 

2,284 2,181 

Rozdiel hmotností [kg] 0,103 
Percentuálny rozdiel 
hmotností [%] 

4,5 

Percentuálne celkové 
zníženie hmotnosti 
spojky [%] 

3 

 

 
Obr. 6.22 Magnetická indukcia v odľahčenom statore MKP modelu s MR kvapalinou 

 

Tab. 6.2  Hmotnostné porovnanie spojky s odľahčeným statorom po obvode 
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Na obr. 6.22 vidno, že na obvode statoru dochádza len k nepatrnému prekročeniu 
hodnoty magnetickej indukcie 0,9 T. Preto môžeme prehlásiť, že sme odľahčili 
statorovú časť po obvode tak, aby nedochádzalo k neefektívnemu využívaniu el. 
prúdu cievky v tejto oblasti. 
Zmena MKP vypočítanej magnetickej indukcie pri spojke odľahčenej po obvode 
statoru oproti spojke neodľahčenej je zobrazená na grafe obr. 6.23. Dochádza 
k veľmi malým rozdielom. Preto aj pri reálnom meraní magnetickej indukcie 
odľahčenej spojky Hallovou sondou očakávame podobné hodnoty aké sme namerali 
pri spojke neodľahčenej. 
 

 
Obr. 6.23 MKP magnetická indukcia v strede meracej drážky pri neodľahčenom a odľahčenom  

statore MR spojky so vzduchom vyplnenou MR medzerou 
 
 

6.7 Experimentálne overenie odľahčenia statorovej časti 
Vyššie navrhované odľahčenie statoru po obvode (2 mm na priemere) bolo 
zrealizované na existujúcej MR spojke pomocou hrotového sústruhu v dielňach ÚK. 
Teraz sme schopní namerať magnetickú indukciu v meracej drážke odľahčenej MR 
spojky pomocou Hallovej sondy a porovnať ju s MKP vypočítanou. 
Pri meraní magnetickej indukcie bolo nutné najprv Hallovu sondu s označením 
STD18-0404 podľa návodu výrobcu skalibrovať, pričom sme pracovali s 
magnetometrom 5180 Gauss/Tesla meter od výrobcu F. W. BELL.  
Ako ďalšia nutná príprava na meranie je odmagnetizovanie spojky. To sme 
uskutočnili metódou prepólovania, ktorá spočíva v niekoľkonásobnej zmene smeru 
a znižovaní veľkosti el. prúdu cievky. Cievku napájame z jednosmerného 
laboratórneho zdroja Manson SDP2603. Hĺbka zasunutia sondy v spojke je určovaná 
pomocou milimetrového papiera viď. obr. 6.24.  
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Obr. 6.24 Príprava pracoviska na meranie Hallovou sondou 

 
Graf nameraných hodnôt magnetickej indukcie je zobrazený na obr. 6.25. Pre 
porovnanie sú v ňom uvedené aj hodnoty MKP vypočítané pri odľahčenom a reálne 
namerané pri neodľahčenom statore. Relatívne malý posuv reálne nameraných 
hodnôt odľahčenej spojky v smere vodorovnej osy je spôsobený chybou merania pri 
určovaní hĺbky zasunutia sondy. Vyššie uvedený predpoklad malej zmeny 
magnetických indukcií pri neodľahčenom a odľahčenom statore po obvode (obr. 
6.23) je potvrdený. Takisto aj MKP vypočítané hodnoty  pri odľahčenom statore sa 
zhodujú s reálne nameranými. 
 

 
Obr. 6.25 Magnetická indukcia v meracej drážke neodľahčenej,  

MKP a reálne odľahčenej spojky 
 

 

0

5

10

15

20

25

30

35

40

0 5 10 15 20 25 30 35 40 45 50 55 60 65 70

M
a

g
n

e
ti

ck
á

 i
n

d
u

k
ci

a
 [

m
T

]

Vzdialenosť od osy hriadeľa [mm]

Real

neodľahčený

stator

MKP odľahčený

stator

Real odľahčený

stator



 

 

Analýza a interpretácia získaných údajov 

strana 

45 

6.8 Odľahčenie lamiel 
Smer toku magnetickej indukcie v lamelách je takmer kolmý na ich čelnú plochu 
(obr. 6.26), ktorej obsah sa ztenšovaním hrúbky lamiel nemení. Preto dosadením do 
vzorca (2) by sme mali dostať rovnakú hodnotu magnetickej indukcie, keďže 
magnetický indukčný tok zostáva konštantný. Preto nepredpokladáme veľkú zmenu 
magnetickej indukcie v lamelách po ich axiálnom odľahčení. 
Výpočtovo overíme tento predpoklad. Odľahčujeme rotorové lamely z hrúbky 5 mm 
na 3 mm (obr. 6.27). Zníženie hmotnosti takto odľahčenej geometrie je uvedené 
v tab. 6.3. Lamely sú z rovnakej ocele ako stator (obr. 6.17). 
 

 
Obr. 6.26 Smer toku magnetickej indukcie odľahčeného MKP modelu s MR kvapalinou 

 

 
Obr. 6.27 Odľahčená rotorová lamela 

 Pôvodné Odľahčené 
Hmotnosť dvoch 
rotorových lamiel [kg] 

0,522 0,314 

Rozdiel hmotností [kg] 0,208 
Percentuálny rozdiel 
hmotností [%] 

40 

Percentuálne celkové 
zníženie hmotnosti 
spojky [%] 

6,1 

Tab. 6.3  Hmotnostné porovnanie spojky s odľahčenými rotorovými lamelami 

6.8 
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V MKP analýze odľahčujeme iba dve rotorové lamely a to z dôvodu jednoduchšieho 
výpočtu. Statorová lamela sa vzhľadom k smeru toku magnetickej indukcie správa 
rovnako, a preto je možné ju takisto rovnakým spôsobom odľahčiť. Pri odľahčení 
všetkých troch lamiel na hrúbku 3 mm by sme ušetrili 0,353 kg čo predstavuje 10,3% 
z celkovej hmotnosti spojky. 
Na obr. 6.28 je graf MKP vypočítaných magnetických indukcií (počítané v strede 
lamiel, model s MR medzerou vyplnenou MR kvapalinou). Dochádza len k malému 
rozdielu hodnôt, čím sme potvrdili predpoklad z úvodu tejto kapitoly. Môžeme 
prehlásiť, že veľkosť hrúbky lamiel je závislá hlavne na pevnosti materiálu 
a očakávanej hodnote prenášaného točiaceho momentu. 
 

  
Obr. 6.28 Magnetická indukcia v rotorových lamelách odľahčeného  

a neodľahčeného MKP modelu s MR kvapalinou 
 
Experimentálne overenie odľahčenia lamiel ovplyvňuje väčšinu súčiastok MR 
spojky. Je potrebné navinúť novú cievku; upraviť geometriu statoru, 
príložky, rámčeku a lamiel; vyrobiť nový obal cievky (obr. 6.29). Po konzultácii 
s vedúcim práce k realizácii tohto odľahčenia do uzavretia bakalárskej práce nedošlo, 
kvôli vyššie spomínanému prílišnému zásahu do konštrukcie spojky.  
 

 
Obr. 6.29 Rez MR spojkou s odľahčenými rotorovými lamelami 
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Obr. 6.30 ukazuje porovnanie MKP vypočítaných magnetických indukcií vo 
vzduchom vyplnenej meracej drážke pri neodľahčených a odľahčených rotorových  
lamelách. Najväčšie rozdiely sú v dvoch oblastiach upravených súčiastok. Prvá 
oblasť je vo vzdialenosti od osy hriadeľa 16 – 30 mm. Druhá je v okolí príložky 
a rámčeku, čo predstavuje vzdialenosť od osy hriadeľa 47 – 60 mm viď obr. 6.2. 
Rozdiel v hodnotách je nevýrazný. Aj napriek tomu by bolo prínosné porovnať 
priebehy nameraných hodnôt magnetickej indukcie Hallovou sondou odľahčenej MR 
spojky s MKP vypočítanými. 
 

 
Obr. 6.30 MKP vypočítané magnetické indukcie v meracej drážke  

modelu s odľahčenými a neodľahčenými rotorovými lamelami 
 
 
6.9 Overenie materiálu statoru a lamiel 
V MKP modeli pracujeme s materiálom statoru a lamiel Steel 1018 90.5 HRB. 
V skutočnosti je v spojke použitý materiál oceľ 11 503 (S355J2G3). Preto je 
potrebné overiť či sa magnetické vlastnosti (B-H krivka) týchto dvoch materiálov 
zhodujú alebo sú aspoň veľmi podobné. Pri meraní magnetickej indukcie Hallovou 
sondou skonštruovanej MR spojky, sa zo zvyšujúcim sa el. prúdom cievky, lineárne 
zvyšuje magnetická indukcia [14]. To isté sme potvrdili aj MKP výpočtom viď obr. 
6.31 (do grafu sme vynášali maximálne hodnoty nameranej a vypočítanej 
magnetickej indukcie, počítané pri vzduchom vyplnenej MR medzere). K lineárnej 
závislosti dochádza z dôvodu konštantnej permeability materiálu statoru a lamiel, 
pretože sa nachádzame v oblasti do 0,9 T (obr. 6.17, obr. 6.20). 
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Obr. 6.31 B-I krivka ocele 11 503 a Steel 1018 90.5 HRB [13] 

 
Tento pokus nepotvrdzuje, a ani nevyvracia, podobnosť materiálu 11 503 a Steel 
1018 90.5 HRB, pretože sme nenašli bod, v ktorom by sa lineárna závislosť menila 
na inú. Preto je vhodné v budúcom vývoji MR spojky zistiť pomocou inej špeciálne 
zameranej analýzy skutočné magnetické vlastnosti ocele 11 503. 
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7 ZÁVER 
Doteraz sme mali výsledky magnetickej indukcie iba v meracej drážke MR spojky 
zmerané Hallovou sondou pri vzduchom vyplnenej MR medzere. Preto sme 
nevedeli, ako sa magnetické pole správa v spojke, ktorá je naplnená MR kvapalinou. 
 
Prínosy: 
 

• Vytvorenie veľmi presného modelu magnetického poľa skonštruovanej MR 
spojky (obr. 16, obr. 24). Zistenie dôležitých prvkov spojky – meracia drážka 
a nepriechodzie diery na hriadeli –  ktoré najviac ovplyvňujú priblíženie sa 
reálne nameraným hodnotám magnetickej indukcie.  

• Vieme ako vyzerá magnetické pole vo vnútri jednotlivých komponentov MR 
spojky. Doposiaľ sme nenašli metódu, ako toto magnetické pole reálne 
zmerať. 

• Je možná modifikácia MR spojky ako napr. zmena tvaru jednotlivých 
komponentov s ohľadom na zmenu magnetického poľa v spojke. 

• Vieme aká je magnetická indukcia v MR spojke naplnenej MR kvapalinou, 
ktorá priamo ovplyvňuje prenášaný točivý moment (obr. 8.1). 

• Zistenie, že pri súčasných rozmeroch statoru pri MR spojke s MR kvapalinou 
dochádza k jeho nasycovaniu, pričom hrúbka lamiel výrazne neovplyvní 
magnetickú indukciu, nimi pretekajúcu. 

Ako ďalšia práca, ktorá by overila príp. zlepšila MKP model magnetického poľa MR 
spojky, je zistenie magnetických vlastností ocele 11 503, z ktorej je vyrobený stator 
a lamely. Jedná sa hlavne o B-H krivku prvotného magnetizovania tohto materiálu. 
 

 
Obr. 8.1 Magnetická indukcia MR kvapaliny LORD 140 CG 

 v MR spojke pri budiacom el. prúde 1,5A 
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PRÍLOHA I – POSTUP PRI VÝPOČTE MAGNETICKÉHO POĽA 
V ANSYS WORKBENCH 
Založenie nového projektu  
Položku Magnetostatic (□) pretiahneme do okna Project Schematic alebo na ňu 
klikneme dva krát. 
 

 
 
 

Výber používaných materiálov 
Po vytvorení Magnetostatic analýzy, dva krát klikneme na položku Engineering 
Data (□). Otvorí sa okno s knižnicami materiálov (□). Tu vyberieme typ materiálov 
(□) a pre konkrétny materiál klikneme na tlačítko Add (□). Pre vrátenie sa do 
projektu klikneme na Return to Project (□). 
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Vloženie pripraveného modelu 
Klikneme pravým tlačidlom na Geometry → Import Geometry → Browse... (□). Po 
správnom načítaní modelu sa vedľa položky Geometry objaví zelená fajka (□).  
 

 
 
 
Úprava geometrie modelu 
Dvojitým klikom na ikonu Geometry alebo pravým tlačidlom → Edit... (□) otvoríme 
nové okno DesignModeler (□). Pre vygenerovanie importovanej geometrie klikneme 
na tlačidlo Generate (□). Priebeh načítavania môžeme pozorovať v Progress lište 
(□). 
 

 
 
 
 
  



 

 
strana 

59 

Samostatné prílohy 
 

Vytvorenie vzduchového okolia 
Na to využijeme príkaz Tools → Enclosure (□). Ten nám v strome príkazov vytvorí 
položku Enclosure (□). Na ňu klikneme pravým tlačidlom a potvrdíme príkaz 
Generate (□), ktorý vygeneruje vzduchové okolie. 
 

 
 
 
Vytvorenie rezu prebytočného vzduchu 
Konce cievky sa musia nachádzať na povrchu okolia, preto jeho časť musíme 
odstrániť. Ako prvé zmrazíme geometriu príkazom Tools → Freeze (□), aby sme 
sprístupnili príkaz Create → Slice (□). Následne vyberieme, v ponuke čím chceme 
rezať, Slice by Surface (□), pretože chceme vytvoriť rez povrchom konca cievky. 
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Pre výber povrchu, ktorým budeme rezať, klikneme na tlačidlo Not selected, ktoré 
svieti na žlto (□). Ľavým tlačidlom vyberieme plochu cievky, tá sa označí na zeleno 
(□) a výber potvrdíme tlačidlom Apply (□). 
 

 
 
 
Podobne ako pri príkaze Enclosure klikneme pravým tlačidlom na Slice (□) a potom 
Generate (□).  
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Odstránenie prebytočného vzduchu 
V predchádzajúcom kroku sme vytvorili rezom nové teleso, ktoré teraz chceme 
odstrániť. Na to nám poslúži príkaz Create → Body Operation (□). Ako typ operácie 
vyberieme vymazanie Delete (□) a teleso odrezanú časť vzduchového okolia (□). 
 

 
 
 
Vytvorenie Multibody part 
V kap. 2.2 je uvedená podmienka Magnetostatic analýzy a to, že ak sa model skladá 
z viacerých častí musí byť spojený do jednej, pretože takáto analýza nepodporuje 
kontaktné elementy. Preto označíme všetky časti spojky (□), klikneme pravým 
tlačidlom a vyberieme možnosť Form New Part (□). Vytvorí sa jediné teleso, ktoré 
sa skladá z častí (□). Tým sme dokončili prácu v DesignModeler  a môžeme ho 
zavrieť. 
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Priradenie materiálu 
V okne Project Schematic dva krát klikneme na položku Model alebo pravým 
tlačidlom → Edit... (□). Materiál priradzujeme každej časti a to tak, že na ňu v okne 
Outline klikneme ľavým tlačidlom (□) a v položke Assignment (□) vyberieme 
materiál, ktorý sme načítali do knižnice (viď. Výber používaných materiálov).  
 

 
 
 
Vytvorenie skupín súčiastok: 
Pre zjednodušenie manipulácie s mriežkovaním je výhodné využiť vlastnosti Named 
Selections grupy. Označíme súčiastky, ktoré chceme v skupine mať a klikneme 
pravým tlačidlom, kde vyberieme príkaz Create Selection Group (□). Po jeho 
odkliknutí, vyskočí tabuľka zisťujúca meno novovytvorenej skupiny (□). 
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Nastavenie mriežky – tvar elementov 
V Outline okne klikneme pravým tlačidlom na položku Mesh → Insert  Method (□). 
V detailoch môžeme vybrať selekciu telies, na ktoré bude mriežka aplikovaná, kde 
nastavíme Named Selection (□). Tu vyberieme skupinu súčiastok Spojka – všetko, 
kde sa nachádza celá spojka (□). Typ elementov nastavíme v záložke Method a to 
konkrétne Tetrahedrons (□). Dôvod, prečo práve tetrahedrony je uvedený v kap. 2.2. 
 

 
 
Nastavenie mriežky – veľkosť elementov 
Podobne ako s výberom metódy mriežkovania vložíme veľkosť elementov (□, □). 
V položke Element Size zadáme požadovanú veľkosť elementov (□). Pre 
vygenerovanie mriežky klikneme pravým tlačidlom na Mesh → Generate Mesh (□) 
alebo ju necháme vytvoriť automaticky pri riešení Solve. 
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Zadanie okrajovej podmienky 
Pravým tlačidlom klikneme na Magnetostatic → Insert → Magnetic Flux Parallel 
(□) a vyberieme 6 rovín vzduchového okolia, ktoré sa po označení sfarbia na zeleno 
(□). Výber potvrdíme tlačidlom Apply (□). 
 

 
 
 
Vloženie budenia 
To zadáme podobne ako okrajové podmienky s tým rozdielom, že vložíme Source 
conductor (□) a ako geometriu vyberieme zjednodušenú cievku, ktorú potvrdíme 
tlačidlom Apply (□). V položke Conductor Type volíme Solid (□), pretože naša 
cievka má geometricky vytvarované závity. 
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Pravým tlačidlom klikneme na Source Conductor → Insert → Voltage (□). Tým do 
Source Conductor položky vložíme Voltage (□). Vyberieme plochu jedného konca 
cievky (□) a potvrdíme výber tlačidlom Apply (□). 
 

 
 
 
Podobne ako Voltage vložíme Current (□), ktorý sa nám v zobrazí v okne Outline 
(□). Vyberieme plochu druhého konca cievky (□) ako sme vyberali pri zadávaní 
Voltage (viz. krok vyššie) a klikneme na tlačidlo Apply (□). Prúd prechádzajúci 
cievkou bude nenulový a preto jeho hodnotu zadáme do kolonky Magnitude (□). 
Vypočítame ju zo vzťahu Um = I.z pričom: Um je elektromotorické napätie a je to 
konštanta, I je prúd prechádzajúci cievkou a z je počet závitov cievky. 
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Zadanie výstupu riešenia – Total Magnetic Flux Density 
Na vykreslenie celkového rozloženia magnetickej indukcie slúži Total Magnetic Flux 
Density (z angl. celková magnetická indukcia) a zadáme ju pravým tlačidlom na 
Solution → Insert → Electromagnetic → Total Magnetic Flux Density (□). Po 
odkliknutí sa objaví položka výsledkov magnetickej indukcie (□). 
 

 
 
 
Zadanie výstupu riešenia – Directional Magnetic Flux Density 
Pre zistenie presne vypočítaných hodnôt magnetickej indukcie v jednom smere 
využijeme nasledujúci postup. Najprv vytvoríme cestu, na ktorej budeme magnetickú 
indukciu vyšetrovať. Vložíme lokálny súradnicový systém pravým kliknutím na 
Coordinate Systems → Insert → Coordinate System (□). V detailoch vyberieme 
Define By → Global Coordinates (□), pretože chceme zadávať počiatok 
súradnicového systému konkrétnymi súradnicami (□). Novo vytvorený lokálny 
súradnicový systém reprezentuje začiatočný bod skúmanej dráhy spojky a môžeme 
ho premenovať (□). Rovnako vytvoríme aj koncový bod. 
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Keď klikneme pravým tlačidlom na Model → Insert → Construction Geometry (□), 
vytvorí sa nová sekcia, kde je možné príkazom Construction Geometry → Insert → 
Path (□) vložiť skúmanú dráhu na spojke. Tú treba definovať začiatočným 
a koncovým bodom, ktoré sme v predchádzajúcom kroku vytvorili (□) a cestu 
premenujeme napr. na „Sonda.“ 
 

 
 
 
Pravým tlačidlom klikneme na Solution → Insert → Electromagnetic  Directional 
Magnetic Flux Density (□). Zadáme Scoping Method → Path (□) a v kolónke Path 
vyberieme predom vytvorenú cestu Sonda (□). Nastavenie smeru magnetickej 
indukcie je v položke Orientation (□). 
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Typ riešenia a výber riešiča 
Typ riešenia môžeme vybrať v kolónke Solver type (□) položky Analysis Settings 
(□). Pre zadanie konkrétneho požadovaného riešiča (viz. kap. 2.2.1) slúži príkaz 
Commands (□), ktorý sa zadáva do samostatného okna (□) a jeho štruktúra je 
popísaná v Helpe [11]. 
 

 
 
 
Spustenie výpočtu 
Výpočet spustíme pravým kliknutím na Magnetostatic → Solve (□). Objaví sa okno, 
ktoré ukazuje priebeh riešenia (□). 
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Zobrazenie výsledkov 
Po úspešnom výpočte budú v Solution všade zelené fajky (□). Total Magnetic Flux 
Density zobrazíme vytvorením pomyselného rezu a to tak, že najprv klikneme na 
ikonu New Section Plane (□) a potom vytvoríme rovinu držaním ľavého tlačidla 
myši (□). Manipulovať s reznou rovinou môžeme posúvaním priamky, ktorú 
zobrazuje (□). 
 

 
 
V prípade výsledkov Directional Magnetic Flux Density po kliknutí na toto okno (□) 
Workbench zobrazí graf (□) a tabuľku (□), ktorú môžeme exportovať do iného 
dátového programu. 
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Výpočtová správa 
Zápis a priebeh výpočtu je možné sledovať v Solution Information (□) aj počas 
výpočtu. Nachádzajú sa tu informácie ohľadom riešiča (□), čas (□) a operačná pamäť 
potrebná na riešenie (□) ako aj rady pre zlepšenie výpočtu. 
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PRÍLOHA II – VHODNOSŤ RIEŠIČOV V MAGNETOSTATIC 
ANALYSIS 
Obr. II.1 zobrazuje jednoduchú úlohu, v ktorej cievkou prechádza el. prúd a ten 
evokuje magnetické pole v kovovom jadre (mag. lineárny materiál). Na tomto 
príklade demonštrujeme vhodnosť jednotlivých riešičov uvedených v kap. 2.2.1. 
Počet elementov mriežky je 72 143. 
 

 
Obr. II.1 Jednoduchá úloha cievky s kovovým jadrom 

 
Pri pohľade na tab. II.1 sa ako najvýhodnejší iteračný riešič zdá QMR, ktorý je 
nasledovaný ICCG a JCG. Výsledné magnetické pole, ktoré vypočítal QMR, je 
nulové, a preto je tento riešič v našom prípade nevyhovujúci. V prípade použitia 
PCG riešiča s automatickým nastavením, sa ku konvergencii nedopracoval. 
Každopádne samotný program Workbench odporúča zmenu parametru MULT na 
hodnotu od 1 do 2,5 a preto, so spresnením MULT = 2, aj riešič PCG vyriešil danú 
úlohu. Iterative typ riešenia použil ako riešič ICCG a rozdiel vo výpočtovom čase je 
spôsobený hľadaním tohto vhodného riešiča. Z hľadiska potrebnej operačnej pamäte 
sa priame riešiče vo všeobecnosti správajú ako náročnejšie oproti iteračným, čo 
potvrdzuje ich charakteristiku z kap. 2.2.1. 
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Typ riešiča Čas riešenia [s] 
Potrebná 
operačná 

pamäť [MB] 
SPARSE 71,6 541 
PCG 1 453 (error) 300 
PCG, MULT = 2 530 298 
JCG 155 227 
ICCG 137 227 
ITER 144 (SPARSE) 541 
QMR 103 227 
AMG 3 660 447 
Program Controlled 134 541 
Direct 106 541 
Iterative 184 (ICCG) 227 

 
  

Tab. II.1  Hmotnosti jednotlivých súčiastok zostrojenej MR spojky 
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PRÍLOHA III – VPLYV VEĽKOSTI ELEMENTOV V MR 
MEDZERE NA VYPOČÍTANÚ MAGNETICKÚ INDUKCIU 
Aby sme zistili ako veľkosť elementu MR medzery ovplyvňuje výsledné magnetické 
pole, vytvoríme elektromagnet (obr. III.1), ktorého medzera je samostatne 
vymodelované teleso o hrúbke 0,5 mm. Dôvod prečo tento vplyv pozorujeme na 
jednoduchej úlohe je technická nenáročnosť oproti riešení konkrétnej MR spojky. 
Porovnávame výsledky Directional Magnetic Flux dráhy v strede MR medzery (obr. 
III.2). 
 

 
Obr. III.1 Elektromagnet s elementom MR medzery 0,5 mm 

 

 
Obr. III.2 Dráha Direcional Magnetic Flux v strede MR medzery 
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Z grafu na obr. III.3 vidno rozdiely v magnetickej indukcii drážky v strede MR 
medzery. Ak vezmeme ako najpresnejšie riešenie hodnoty pri veľkosti elementu MR 
medzery 0,5 mm; tak sa od nej najviac odlišuje 1,5 mm element; pri ktorom je 
najväčšia relatívna chyba veľká 0,532%. Vzhľadom na rýchlosť výpočtu a počet 
elementov to považujeme za zanedbateľný rozdiel.   
 

 
Obr. III.3 
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PRÍLOHA IV – DEFINOVANIE VLASTNÉHO MAGNETICKY 
NELINEÁRNEHO MATERIÁLU DO ANSYS WORKBENCH 
Inštalácia .xml programu: 
Dáta, ktoré charakterizujú vlastnosti materiálov v Enginnering Data, sú v ANSYS 
Workbench uložené v súbore s koncovkou .xml. Preto potrebujeme ako prvé 
nainštalovať program, ktorý dokáže takéto súbory editovať (Microsoft Excel 
podporuje len ich otváranie a nie editáciu). Takýchto programov je viacero aj 
v neplatených verziách a my využijeme EditX 2010.  
 
Vytvorenie novej galérie materiálov 
Súbor s cestou ANYSInc/v121/Addins/EngineeringData/Language/en-
us/Samples/Magnetic_B-H_curves_Soft_Materials skopírujeme na plochu 
a premenujeme. 
 

 
 
 
Úprava dát v EditX 2010 
Po spustení editačného programu otvoríme skopírovaný súbor dát materiálov .xml 
(□). 
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Následne sa otvorí zdrojový kód. Tu prepíšeme názov materiálu (□) a zmeníme 
súradnice B-H krivky (□,□) a uložíme (□). 
 

 
 
 
Načítanie upravenej galérie do ANSYS Workbench 
Dvojitým kliknutím na Engineering Data (□), sa otvorí okno kde klikneme na 
pridanie novej knižnice (□) a otvoríme (□). 

;
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Výsledný vytvorený materiál 
Načítala sa upravená galéria materiálov, kde máme aj nami zadanú MR kvapalinu 
Lord 140 CG. 
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